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INTRODUCTIE 
 

Kurk is plantenweefsel dat gevormd wordt door cellen gevuld met een gasmengsel vergelijkbaar met 

lucht. De cellen zijn verbonden met natuurlijke polymeren; de belangrijkste zijn suberine (45%), 

lignine (27%) en polysachariden (12%). Dit bijzondere natuurlijke product is gewoon de schors van 

de kurkeik, de enige boom met een hernieuwbare schors.  

Van alle kurkeiken in de wereld groeit ongeveer 50% in Portugal. Portugal verzorgt 55% van de 

jaarlijkse kurkproductie in de wereld.  

Het schillen van de kurkeik om kurk te winnen zonder de schors onherstelbaar te beschadigen, wordt 

uitgevoerd door professionals. Op deze manier kan de kurkeik om de negen jaar geschild worden. 

Een kurkeik kan echter pas na 25 jaar voor het eerst geschild worden. Deze eerst gewonnen kurk kan 

goed gebruikt worden als ruw materiaal voor thermische en akoestische isolatie. Kurk wordt 

wereldwijd gebruikt vanwege de unieke eigenschappen. Momenteel wordt kurk voor veel meer 

doeleinden gebruikt dan alleen kurken stoppen of vloeren van kurk. In de in 2012 door de European 

Space Agency (ESA) gelanceerde Vega-raket bijvoorbeeld, werd kurk gebruikt in de neuskegel en 

andere temperatuurgevoelige plekken om oververhitting te voorkomen. In de context van duurzame 

ontwikkeling kan kurk een belangrijke rol vervullen. Het is een natuurproduct, hernieuwbaar, 

recyclebaar, niet giftig en het heeft exceptioneel goede milieu-eigenschappen. Bovendien biedt kurk 

innovatieve technologische mogelijkheden.  

Tijdens een reis naar de provincie Alentejo, werden de vrienden, Vasco en Isabel, zeer verrast toen 

ze grote mooie bomen zagen waarvan de schors onlangs was verwijderd. 

Ze vroegen de werkers of het verwijderen van de schors schadelijk was voor de bomen. De werkers 

grinnikten en vertelden hen dat de schors die ze verwijderd hadden gewoon kurk was, het materiaal 

dat ook voor de stoppen voor flessen gebruikt wordt.  

Isabel herinnerde zich een foto die haar ouders gemaakt hadden tijdens de Expo 2000 in Hannover. 

Het was een foto van het Portugees Paviljoen, waarvan de wanden gemaakt waren van kurk! (Zie 

figuur 1) Ze werden nieuwsgierig en wilden graag meer weten van de fantastische kurkeik en de kurk 

die geproduceerd werd en de mogelijke toepassingen daarvan. 

 

Figuur A – Portugees Paviljoen tijdens Expo 2000 in Hannover. 

Álvaro Siza Vieira en Eduardo Souto Moura, Portugese architecten en winnaars van de Pritzker-prijs, 

gebruikten gewone kurkplaten en hoge-dichtheid-kurkplaten als bedekking van sommige gevels. 

In deze taak gaan jullie meer leren over kurk en hopelijk begrijpen jullie daarna waarom kurk 

beschouwd wordt als een bijzonder natuurproduct. 
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Met dit doel, ga je Vasco en Isabel laten zien hoe je de kurkeiken kunt identificeren die de beste kurk 

produceren voor het gebruik van stoppen voor wijnflessen. Je gaat ook de kwaliteit van de stoppen 

van kurk onderzoeken en laat Vasco en Isabel zien dat kurk een efficiënte thermische isolator is. 

 

Deze taak bevat de volgende 4 opdrachten:  

 

Taak 1 - 1 – Identificeren van belangrijke kenmerken van kurk en de kurkeik.    60 punten 

 

Taak 1 - 2 – Selectie van de perfecte kurkeik om eersteklas kurken voor wijnflessen te maken 

60 punten 

 

Taak 1 - 3 – Bepaling van het totale fenolgehalte en van de kwaliteit van kurk.                  120 punten 

 

Taak 1 - 4 – Kurk als thermische isolator                                                                                    120 punten 
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OPDRACHT 1 - 1.: IDENTIFICEREN VAN BELANGRIJKE KENMERKEN VAN KURK EN DE 

KURKEIK.  

Inleiding 

Er zijn ongeveer 200 soorten die behoren tot het genus (geslacht) Quercus (eik), maar slechts één 

daarvan heeft de mogelijkheid voortdurend een product te leveren met hele bijzondere en 

waardevolle eigenschappen: kurk. De bast van de kurkeik heeft een bijzondere structuur met dicht 

op elkaar gepakte verkurkte cellen genaamd phellem (kurkcellen), dat we kennen als kurk.  

Voor de kwaliteit van kurk zijn twee aspecten belangrijk, de dikte van de kurklaag en de (porositeit 

(poreusheid) van de kurklaag. De dikte heeft te maken met de jaarlijkse groei dus het aantal per jaar 

gevormde kurkcellen. Je verkrijgt kurk door de bast van de kurkeik er af te schillen en dat gebeurt 

tegenwoordig om de 9 jaar. In de schillen kun je de jaarringen zien. Zie afbeelding. 

 

De afbeelding toont schematisch een 

dwarsdoorsnede van de afgepelde schil van 

een kurkeik. 

Het kurkcambium (11) produceert jaarlijks 

kurkcellen en kurk schors waardoor de 

bastlaag dikker wordt. Je ziet hier 9 

jaarringen, 1 is de jongste, 9 is de oudste.  

De dikte van de verkregen schillen kurk kun 

je met een schuifmaat meten, maar dikte en 

kwaliteit hangen niet direct samen. Hele 

dunne schillen zijn onbruikbaar om verder te 

verwerken, terwijl hele dikke schillen veel te 

gasdoorlatend (poreus) zijn. Het gaat dus om 

het verkrijgen van de juiste dikte van de schil. 

De porositeit hangt samen met de 

aanwezigheid van straalsgewijs naar buiten 

lopende zogenaamde lenticellen. 

 

De kwaliteit van kurk hangt samen met de genetische eigenschappen van iedere individuele boom 

en groeicondities. Die groeicondities kunnen zowel abiotisch (bijv. beschikbaarheid van water) als 

biotisch (bijv. ziekteverwekkers) zijn. 

In opdracht 1-1 moet je nagaan welke plant de kurk eik is en in opdracht 1-2 gaat het om de 

belangrijkste kenmerken verbonden met de kwaliteit van kurk.  

 

Benodigdheden en apparatuur 

● Petrischalen met plantaardig materiaal van 5 verschillende plantensoorten (A t/m E), ieder in 

een aparte petrischaal. Het gaat om: 

o Blaadjes, vruchten, en kleine stukjes van takjes (deze microplakjes zitten apart in 

kleine petrischaaltje en zijn bestemd voor kleuring met Soedanrood) 
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o Een petrischaaltje met kleine microplakjes kurk als positieve controle op de 

Soedanrood kleuring (gelabeld met “+”) 

● Foto’s van de takjes, vruchten, blaadjes en de vorm van de plantensoorten A t/m E 

● Appendix 1. Een overzicht van morfologische kenmerken (vormkenmerken) van biologisch 

materiaal 

● Doosje met microscoop glaasjes 

● Doosje met dekglaasjes 

● Pincet 

● 20 μL Micropipet 

● Doosje met 20 μL Micropipet puntjes 

● Gedeïoniseerd water in een 10 mL reageerbuisje (gelabeld met “H2O”) 

● Soedanrood reagens in een 10 mL reageerbuis (gelabeld met “Sudan Red”) 

● 70% alcohol (ethanol) oplossing (gelabeld met “EtOH”) 

● 3 plastic Pasteur pipetjes 

● Een plastic plaatje met 24 gaatjes (24 Well Cell Culture Plate) 

● Twee 500 mL plastic bekerglazen voor afval 

● Stopwatch, ook te gebruiken in Opdracht I.3 

● Lichtmicroscoop 

● Stereomicroscoop (moet je delen, één per twee groepen) 

Als je iets morst of iets van het glaswerk breekt of het biologische materiaal kapot maakt en 

vervanging wil, dan kun je om hulp vragen bij de lab assistant. 

Vervanging van het material in bovenstaande lijst kost je 5 punten, maar … 

Vervanging van biologisch material kost je 10 punten. 

 

1 - 1.1. Herkennen (identificeren) van de kurkeik. 

Op je werkplek vind je 5 petrischalen met biologisch materiaal (gemerkt A t/m E) van 5 

verschillende soorten plantensoorten. Eén van hen is de kurkeik. Wees voorzichtig met de 

aanwezige dunne plakjes.   

In deze opdracht moet je met behulp van een aantal experimenten nagaan wat ieder van A t/m E is. 

Met behulp van je experimenten met de aanwezige biologische materialen, de foto’s en Appendix 1 

moet je vervolgens de bijbehorende tabellen op het antwoordblad invullen.  

Bij het invullen moet je met een kruis (X) de antwoorden aangeven, die het beste passen bij je 

waarnemingen. Het is mogelijk dat er soms meer dan één juist antwoord is.  

Als je een fout antwoord geeft dan kost je dat 20 % van de punten op dat onderdeel. 

Per niet gegeven juist antwoord krijg je 10% aftrek op dat onderdeel 

 

1 - 1.1.1. Instructies  

Lees de tabel zorgvuldig voordat je begint met je waarnemingen.  

Vermijd overbodige werk, en zorg er voor dat je niet in de war raakt met het pakken van A 

t/m E materiaal uit de verschillende petrischalen.   
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Waarnemingen aan het biologische material EN de foto’s. 

1. Beharing van blaadjes bekijken.  

Leg een blaadje op een objectglaasje en bekijk het direct met de microscoop op de kleinste 

vergroting. Gebruik geen water. Bekijk het blad aan beide kanten (boven- en onderkant).  

Doe dit voor alle aanwezige blaadjes en kijk bij ieder blad op verschillende plekken.  

2. Waterdruppel test: 

Kies weer een blaadje en neem met met een micropipette een drup van 10 µL water. Breng 

voorzichtig, dus zonder druk de druppel op de bovenkant van het blaadje. Doe dit op 10 

verschillende plekken. Zorg voor tenminste één drup op de centrale middennerf. Herhaal dit 

met de onderkant van het andere blaadje. Je moet dit doen voor A t/m E.  

3. Bekijk met de stereomicroscoop de vorm van alle drupjes op de blaadjes. 

4. Als je kijkt naar de onderkant moet je vervolgens iets extra’s doen. Houd het blaadje vertikaal 

en kijk wat er gebeurt. Verandert de vorm van de drupjes of glijden ze weg. Baseer je antwoord  

op het gedrag van de meerderheid (meer dan  6) van de 10 blaadjes voor ieder van A t/m E.  

5. Droog alle drupjes met papier (is ergens in de zaal) en doe alles terug in de bijbehorende 

petrischalen. 

Soedanrood test. 

Gebruik de plastic 24 gaatjes plaat om de kleine microplakjes te kleuren. 

Gebruik 3 gaatjes voor ieder van A t/m E. Pipetter 0,5 mL van de Soedanrood oplossing, 0,5 mL 

van de 70% alcohol oplossing of 0,5 mL water per gaatje. 

Zie hieronder hoe je dat het beste kunt doen, maar lees eerst verder.  

In gaatje A1 t/m A6 70% ethanol solution;  

In gaatje B1 t/m B6: Soedanrood oplossing 

In gaatje C1 t/m C6 water; 

Gaatje D1 t/m D6 blijven leeg. 

Gebruik gaatje A1, B1 en C1 voor soort A,  

Idem gaatje A2, B2 en C2 voor soort B, enz. 

Gebruik gaat A6, B6 en C6 voor de positieve controle. 

 

Je vindt alle reagentia in de aanwezige 10 mL reageerbuizen. 

Gebruik de pincet voor het opnemen en overbrengen van de microplakjes. 

Doe de microplakjes eerst gedurende 1-2 minuten in de 70% alcohol oplossing en daarna 10 

minuten in de soedanrood oplossing. Haal ze er weer uit, was ze opnieuw 1-2 minuten in de 70% 

alcohol oplossing en tenslotte 1-2 minuten in (gedeïoniseerd) water. 

Bekijk vervolgens alle preparaten onder de microscoop. Kijk naar verschillende stukjes.  

Zorg dat je zo efficient mogelijk werkt met alle materialen en de lichtmicroscoop en 

stereomicroscoop. 

Als je het biologische materiaal tussen de schalen verwisselt kost je dat 20 punten. 
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Vraag 1.1.a 

Na alles wat nodig is gedaan te hebben vul je alle onderdelen van tabel 1.1.a in op het 

antwoordblad. 

❖ Vul het ID nummer in van jouw materiaalset  

❖ Vul je resultaten in bij 1.1a. op het antwoordblad. 

Vraag 1.1.b 
Na al je waarnemingen gedaan te hebben moet je de determineer sleutel gebruiken om na te gaan 

welke soort (A t/m E) aanwezig is in ieder van de petrischalen. Match de juiste soortnaam met de 

juiste petrischaal.  

❖ Vul je antwoord(en) in bij Vraag 1.1.b op het antwoordblad. 

Vraag 1.1.c 
Bij welk soort bladoppervlak verwacht je huidmondjes te vinden? 

❖ Geef je antwoord 1.1.c op het antwoordblad. 

Vraag 1.1.d  
Wat is het voordeel van een sterk behaard blad? 

❖ Geef je antwoord bij 1.1.d op het antwoordblad. 

Vraag 1.1.e 
Naar welk onderdeel van de plant kun je het beste kijken om te bepalen of de desbetreffende plant 

een monocotyl (éénzaadlobbige) of een dicotyl (tweezaadlobbige) is? 

❖ Geef je antwoord bij 1.1.e op het antwoordblad. 

Vraag 1.1.f 
Je moet een Soedanrood kleuring doen met microplakjes van verschillende plantensoorten. Je ziet 

waarschijnlijk een donker gekleurd laagje aan de buitenkant. Wat zal de functie zijn van dit laagje? 

❖ Geef je antwoord bij 1.1.f op het antwoordblad. 
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TAAK 1 - 2.: SELECTIE VAN DE PERFECTE KURKPLANT OM EERSTEKLAS KURKEN VOOR 

WIJNFLESSEN TE MAKEN 

Inleiding 

Nu je erin geslaagd bent te bepalen welk monster afkomstig is van de boom Quercus suber, beter 

gekend als de kurkeik, hebben we weerom je hulp nodig om te bepalen welk monster van kurkplanken 

we dienen te gebruiken om kurken voor wijnflessen te maken. 

Voor je onderzoek hebben we planken van drie verschillende bomen genomen. Elke boom levert een 

ander kurktype. (Figuur 1 - 2.1). Bestudeer de textuur, de poreusheid en de onvolmaaktheden van elk 

monster. Kurkplanken met veel onvolmaaktheden, of met een breedte die niet voldoet, zijn niet 

geschikt voor de productie van kurken. 

 

Figuur 1 - 2.1 – Hierboven heb je een afbeelding van de buitenzijde van elk van de 3 planken (labeled A - 

C). 

 

Het is mogelijk de invloed van omgevingsfactoren op elke boom waar te nemen. Zo groeien 

kurkcellen niet in de winter; zij groeien enkel in de lente en in de zomer. De snelheid waarmee ze 

groeien wordt bepaald door de fysiologische toestand van de boom en over de hoeveelheid 

beschikbaar water. In de lente kan je meer celdelingen waarnemen, wat dan resulteert in grotere cellen 

met dunnere celwanden. In de zomer zijn er minder celdelingen, wat cellen oplevert die op een andere 

manier zijn samengesteld (harder en donkerder). 

De invloed van de omgeving kan bij elke boom waargenomen worden door te kijken naar de 

groeiringen. Het uitzicht ervan kan je verdere informatie geven over groeiomstandigheden, zoals 

invloed van het klimaat, insectvraat, brand en de hoeveelheid beschikbaar licht. 

In deze opdracht dien je de gemiddelde fractie van het kurkmateriaal te bepalen die onvolmaaktheden 

vertoont zoals voorkomend in de drie planken afgebeeld in Figuur 1 - 2.1 (voor het geval je deze 

onvolmaaktheden wil waarnemen: één monster van elke plank is voorhanden in het labo). Het 
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monster met een geschikte dikte en met het kleinste aantal onvolmaaktheden is het best geschikt voor 

de productie van kurken stoppen.  

Materiaal en uitrusting 

● Computer 

● Per lab: één set kurken stoppen voor observatie  

1 - 2.1. Controle van de kwaliteit van een kurken plank: kwantificeren van de 

onvolmaaktheden 

Volg de hieronder beschreven werkwijze: 

1. Open het computerprogramma ImageJ op de desktop. 

2. In ImageJ, open de bestanden A tot C (command File>Open) (Folder Images_EUSO). Deze 

afbeeldingen werden gemaakt met een digitale scanner en opgeslagen in RGB kleurformaat. 

3. Extraheer de informatie in elk kanaal via het commando Image>Color>Split Channels. Dit 

commando zal de informatie van de Rode, Groene en Blauwe kanalen opsplitsen in drie 

verschillende afbeeldingen. 

4. Gebruik voor elke afbeelding het commando Image>Lookup Tables>Grays (om de kleur van elk 

frame om te zetten in Grijs). Voer nu het commando Image>Adjust>Brightness/Contrast in (om 

de intensiteit van de pixels in elke afbeelding aan te passen) en kies de optie ‘Auto’.  Kies 

tenslotte de optie File>Save As>Tiff (om elke afbeelding in TIFF-formaat te bewaren). Wijzig 

nu de naam voor elke afbeelding zodanig dat de kleur duidelijk wordt weergegeven.  

5. Voor elke plank (monsters A tot C) krijg je 3 afbeeldingen. Bepaal nu voor elk monster welke 

afbeelding je in de volgende stappen gaat gebruiken. 

Vraag 2.1.a 

Welk kanaal of welke kanalen la(a)t(en) je het beste toe de groeiringen waar te nemen?  

❖ Vul je resultaten in bij Vraag 2.1.a op je antwoordblad. 

6. Nadat je de afbeelding hebt gekozen die je wil analyseren, bewaar deze met een andere naam 

zoals “Image_1 - tif”. Open vervolgens de afbeelding met het commando File>Open en kies in 

de toolbar de knop die overeenstemt met een rechthoekige selectie (1ste knop links). Selecteer het 

kurkoppervlak dat je wenst te analyseren. Let op dat je de zwarte achtergrond niet mee selecteert.  

7. Kopieer de informatie binnen de selectie met het commando Edit>Copy to System. 

8. Kies de optie File>New>System Clipboard. Deze stap zal de informatie die je net gekopieerd 

hebt plakken in een nieuw RGB-bestand. 

9. Kies de optie Image>Type>8-bit om het bestand van een RGB kleur formaat om te zetten in een 

8-bit formaat. 

10. Kies de optie File>Save As>Tiff (om het geselecteerde gebied te bewaren in TIFF formaat). 

Bewaar als Image_A_crop_1.tif. 

11. Kies de optie Image>Adjust Threshold en stel de intensiteit van de intensiteit van de pixels in 

het “Threshold” venster zodanig in, dat de donkere gebieden die je wenst te kwantificeren 

inbegrepen zijn. Zodra je tevreden bent met de gekozen gebieden kies “Apply”. De geselecteerde 

gebieden zullen wit gekleurd worden met een pixel-intensiteit = 255. De andere gebieden zullen 

zwart gekleurd worden met een pixelintensiteit = 0. 
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12. Kies de optie Analyze>Set Measurements en definieer wat je wenst te meten en het aantal 

decimalen 

13. Kies de optie Analyze>Measure en noteer de bekomen waarden in het venster “Results”. Dit is 

de oppervlakte van de gehele afbeelding in pixels2 (pixel x pixel). 

14. Sluit het venster “Results”. 

15. Kies de optie File>Save As>Tiff om een afbeelding te bewaren van het oppervlak met witte 

pixels. Bewaar de afbeelding als Image_A_crop_1 _threshold.tif 

16. Kies de optie Analyze>Analyze Particles bepaal welke parameters je zal nodig hebben. We 

stellen voor dat je de optie “Outlines” in “Show:” kiest (om de gebieden waar te nemen die je 

hebt geselecteerd) en dat je op de opties “Display Results” en “Add to Manager” klikt (om de 

resultaten in een file te bewaren die je kan openen in de OpenOffice spreadsheet die eveneens op 

de desktop staat). Klik vervolgens op “OK”. 

17. Je zal nu in staat zijn om elke Region of Interest (ROI) te selecteren in het venster “ROI Manager” 

en dit gebied zien in het venster met je afbeelding. Selecteer alle ROI en bewaar het bestand in 

dezelfde folder als degene waarin je al je ImageJ bestanden hebt bewaard. De waarden van de 

oppervlakte van elke ROI worden weergegeven in het venster  “Resultaten” in pixels2. 

Vergeet niet je bestanden zodanig te organiseren en te bewaren zodat het mogelijk is te 

controleren dat je correct het voorgesteld protocol hebt gevolgd. Deze informatie zal in 

aanmerking genomen worden bij de classificatie van de vragen 2.1.b tot 2.1.e. 

Vraag 2.1.b 

Hoeveel bestanden heb je aangemaakt met het protocol dat je gevolgd hebt om het percentage van 

het oppervlak met onvolmaaktheden te bepalen in de kurkmonster A tot C? Houd ook rekening met 

de bestanden die je gemaakt hebt met de spreadsheetsoftware op de computer. 

❖ Vul je resultaten in bij Vraag 2.1.b op het antwoordblad. 

Vraag 2.1.c 

Welk oppervlak van de kurkstalen A tot C heb je in aanmerking genomen bij het bepalen van het 

percentage van de oppervlakte met onvolmaaktheden? Teken op je antwoordblad dit oppervlak met 

de waterproof marker. 

❖ Vul je resultaten in bij Vraag 2.1.c op het antwoordblad. 

Vraag 2.1.d 

Bepaal het percentage van het oppervlak met onvolmaaktheden in de kurkmonsters A tot C. Welk 

monster heeft het kleinste oppervlaktepercentage met onvolmaaktheden? Om dit te beantwoorden 

moet je de OpenOffice spreadsheet op je computer gebruiken. 

❖ Vul je resultaten in bij Vraag 2.1.d op het antwoordblad. 
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Vraag 2.1.e 

Teken een staafdiagram met het percentage aan donkere gebieden in de 3 kurkplanken. Gebruik 

hiervoor de waarden die je gemeten hebt in de vorige vraag 

❖ Vul je resultaten in bij Vraag 2.1.e op het antwoordblad. 

Vraag 2.1.f 

Hoeveel groeiringen kan je makkelijk waarnemen in plank A? 

❖ Vul je antwoord in bij Vraag 2.1.f op het antwoordblad. 

 

Bekijk voor de volgende vragen Figuur 1 - 2.2, waarop je 10 verschillende lagen kan waarnemen, die 

het resultaat zijn van 10 opeenvolgende groei-jaren. 

 

 

 

 

 

 

 

 

 

 

Figuur 1 - 2.2 – Beeld van het lateraal oppervlak van één van de planken die je hebt bestudeerd 

Vraag 2.1.g 

Hoe verklaar je de lichtere en de donkerder zone’s? Kies de beste hypothese. 

❖ Vul je antwoord in bij Vraag 2.1.g op het antwoordblad. 

Vraag 2.1.h 

In welk jaar denk je dat het veel geregend heeft? 

❖ Vul je antwoord in bij Vraag 2.1.h op het antwoordblad. 

Vraag 2.1.i 

Geef de gebieden aan, die volgens jou overeenstemmen met lente- en zomergroei. 

❖ Vul je antwoord in bij Vraag 2.1.i op het antwoordblad. 

Vraag 2.1.j 

Welke laag/groeiring werd blootgesteld aan de atmosfeer? 

❖ Vul je antwoord in bij Vraag 2.1.j op het antwoordblad. 
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TAAK 1 - 3.: BEPALING VAN HET TOTALE FENOLGEHALTE EN VAN DE KWALITEIT VAN KURK 

Introductie 

Door zijn unieke fysische en chemische eigenschappen is kurk een uitstekende stop (afsluiter) voor 

wijnen, mousserende wijnen, likeuren en andere dranken. Zoals uit de vorige taak (1 – 2) bleek 

kunnen niet alle soorten kurk hiervoor gebruikt worden. 

Kurkplanken met een te grote doorlaatbaarheid (permeabiliteit) of van de verkeerde dikte kunnen niet 

gebruikt worden om stoppen van te maken. Ook kunnen kurk-aroma's een negatief effect (een 

aromadefect) hebben op de geur en smaak van een wijn. 

De kurk-aroma's worden veroorzaakt door de aanwezigheid van chemische stoffen met een 

microbiologische oorsprong. Hoewel de fractie van wijnen die last heeft van een aromadefect heel 

laag is, hebben producenten van kurken stoppen geprobeerd dit verder te reduceren door 

kwaliteitscontroles uit te voeren. Een van deze methodes betreft de analyse van fenolen die kunnen 

leiden tot de aanwezigheid van 2,4,6-trichlooranisol (TCA), dat een muffe/schimmelachtige geur en 

smaak aan de wijn kan geven.  

TCA wordt gevormd door micro-organismen zoals schimmels, wanneer deze in contact komen met 

chloorbevattende stoffen, meestal chloorfenolen, zoals weergegeven in figuur 1 - 3.1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figuur 1 - 3.1 – De vorming van 2,4,6-trichlooranisol (TCA).  

1 - lignine; 2 - fenol; 3 - 2,4,6-trichloorfenol (TCP); 4 - 2,4,6-trichlooranisol (TCA); A - gisten;  B - 

biomethylering door schimmels. 

 

Omdat fenol een afbraakproduct van kurk zelf is, is het fenolgehalte een belangrijke parameter voor 

het bepalen van de kurkkwaliteit en voor de mogelijke toepassingen van de kurk. 

In deze taak ga je de hoeveelheid fenol in kurkmonsters bepalen en daarmee de geschiktheid van de 

kurk voor het maken van kurken stoppen. 

Voor het bepalen van het fenolgehalte wordt Folin-Ciocalteu (FC) reagens gebruikt. Dit FC reagens 

bevat complexen van fosformolybdeenzuur en van fosforwolfraamzuur. De bepaling maakt gebruik 

van de afgifte van elektronen door fenolen in basisch milieu, waardoor de complexen van 

fosformolybdeenzuur en fosforwolfraamzuur gereduceerd worden en een blauwe verbinding vormen. 

De kleurintensiteit hangt af van de concentratie van de fenolen. Het gereduceerde FC reagens kan 

gedetecteerd worden met een spectrofotometer bij golflengtes tussen 600 nm en 710 nm. 
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De wet van Lambert-Beer relateert de concentratie van een verbinding aan de extinctie volgens:  

A = εcd 

Deze wet voorspelt een lineaire relatie tussen de extinctie (A, van het Engelse 'absorbance') en de 

molariteit (c) van de verbinding als d, de 'dikte' van de cuvet constant blijft. De extinctiecoëfficiënt ε 

is een constante die karakteristiek is voor de verbinding in een bepaald oplosmiddel. Hiermee is het 

mogelijk de concentratie (in mg L-1 of in mol L-1) van een gegeven verbinding te bepalen uit de 

extinctie als de dikte van de cuvet (in cm) en de extinctiecoëfficiënt (in L mg-1 cm-1 of L mol-1 cm-1) 

bekend zijn. 

Materialen and apparaten 

● 10 maatkolven van 50 mL 

● 15 bekerglazen van 25 mL 

● 2 volpipetten van 3,00 mL 

● 1 volpipet van 5,00 mL 

● 1 volpipet van 10,00 mL 

● 1 volpipet van 20,00 mL 

● 1 volpipet van 25,00 mL 

● 1 pipetteerballon 

● 1 micropipet van 1000 μL 

● 1 doos met pipetpuntjes voor de 1000 μL micropipet 

● 3 plastic pasteurpipetten 

● 5 plastic cuvetten met een dikte van 1 cm en een inhoud van 2 mL 

● 2 plastic bekerglazen van 500 mL voor afval 

● 1 watervaste stift 

● 2 plastic flessen met 500 mL gedemineraliseerd water (gemarkeerd met “H2O”; deze mogen 

opnieuw gevuld worden, dat levert geen strafpunten op) 

● 100 mL van een standaardoplossing van galluszuur (0.00050 mol L-1), 100 mL (gemarkeerd 

met “Gallic Acid”) 

● 20 mL van een standaardoplossing van Folin-Ciocalteu (gemarkeerd met “Folin”) 

● 20 mL van een 7,5 massa-% oplossing van natriumcarbonaat (gemarkeerd met “Na2CO3”) 

● 2 mL elk, van drie verschillende kurkextracten (gemarkeerd met “Lot A”; “Lot B” en  

“Lot C”) 

● 1 colorimeter 

● 1 TI-Nspire CX 

● 1 TI-30X rekenmachine (in de bak voor algemeen gebruik) 

● 1 stopwatch (in de bak voor algemeen gebruik deze is ook nodig voor opdracht 1 – 1) 

 

Als je iets morst of breekt en een vervanging nodig hebt, vraag dan een zaalassistent om hulp. 

Elke vervanging van iets uit de lijst hierboven kost 5 punten, tenzij anders aangegeven. Extra 

kurkextracten kosten 10 punten. 
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1 - 3.1. De helling (m) van de kalibratielijn 

Galluszuur wordt traditioneel gebruikt in de bepaling van het totale fenolgehalte van verschillende 

natuurproducten. Je eerste opdracht is het bepalen van het product εd uit de wet van Lambert-Beer, 

oftewel de helling m, met behulp van een aantal verdunningen die je kunt maken uit de 

standaardoplossing van galluszuur (5,0∙10-4 mol L-1).  

 

Figuur 1 - 3.2 – De molecuulstructuur van galluszuur 

Maak van elke verdunning 50 mL door met behulp van de juiste pipet en de pipetteerballon (zie 

Appendix 2) de volumes uit tabel 3.1 in een maatkolf te pipetteren en de maatkolf aan te vullen met 

water. 

Table 3.1 

Verdunningen gemaakt uit de standaardoplossing 
 

Verdunning 

Te pipetteren volume 

standaardoplossing 

(0,00050 mol L-1 galluszuur) 

S1 3,00 

S2 5,00 

S3 10,00 

S4 20,00 

S5 25,00 

 

Vraag 3.1.1. 

Bereken de concentraties (in mg L-1) van de verdunningen die je gemaakt hebt. Geef de waarden in 

twee decimalen nauwkeurig. 

❖ Schrijf je berekeningen op, op het antwoordblad bij vraag 3.1.1 en schrijf de resultaten 

in de tabel. 
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1 - 3.1.1. Het maken van de kalibratie-oplossingen 

1. Gebruik de micropipet om telkens nauwkeurig 500 µL van elke verdunning in een bekerglas van 

25 mL te pipetteren en om hieraan vervolgens telkens 500 µL FC reagens toe te voegen. Roer, 

wacht 3 minuten en voeg dan met de micropipet 500 µL mL van de Na2CO3 oplossing toe. 

2. Maak de blanco-oplossing op dezelfde manier als de kalibratie-oplossingen, maar gebruik  

500 µL H2O in plaats van een verdunning. 

3. Roer alle oplossingen en laat ze 30 minuten staan. 

4. Sluit de colorimeter aan, wacht vervolgens ongeveer 5 minuten en kalibreer dan de colorimeter 

(zie de instructies voor de vernier colorimeter in Appendix 3).  

5. Meet na punt 3 en 4 de extincties van de gemaakte oplossingen bij een golflengte van 635 nm met 

behulp van de colorimeter. Schrijf de meetwaarden op in twee decimalen nauwkeurig. 

Vraag 3.1.2. 

❖ Schrijf de meetwaarden op in de tabel bij vraag 3.1.2. 

Vraag 3.1.3. 

Zet op het grafiekpapier de extinctie (A) uit tegen de galluszuurconcentratie (Cgalluszuur)  

❖ Gebruik het millimeterpapier bij vraag 3.1.3 op het antwoordblad. Zet alléén de 

meetpunten uit in de grafiek. 

Vraag 3.1.4. 

Je gaat nu met behulp van A en Cgalluszuur uit vraag 3.1.2 de helling van de best passende rechte lijn 

door de datapunten data bepalen.  

De vergelijking van deze lijn kan worden bepaald door middel van de 'methode der kleinste 

kwadraten'. In deze methode wordt de som (=optelling) van de kwadraten van de verschillen  

(= aftrekkingen) tussen de gemeten extincties en de door de lijn voorspelde extincties 

geminimaliseerd. 

Start met het berekenen van twee 'kwadratensommen' zoals weergegeven in de voorbeeldtabel 

hieronder. 

Voorbeeld van de berekeningen die nodig zijn om de helling van de kalibratielijn te bepalen met 

behulp van de methode der kleinste kwadraten. 

 

𝒙𝒊
𝟐 𝒙𝒊 ⋅ 𝒚𝒊 

𝑥1
2  𝑥1 ⋅ 𝑦1  

… … 

𝑥5
2  𝑥5 ⋅ 𝑦5  

𝑺𝒙𝟐 = de vijf 𝑥𝑖
2 bij 

elkaar opgeteld 
 

𝑺𝒙𝒚 = de vijf 𝑥𝑖 ⋅ 𝑦𝑖 bij 

elkaar opgeteld  
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Bereken m nu als volgt: 

          

❖ Vul de tabel bij vraag 3.1.4 op het antwoordblad verder in, zodat je de 

kwadratensommen krijgt die je nodig hebt om de helling te berekenen  

❖ Schrijf je berekeningen en de resulterende helling m op in het vak bij vraag 3.1.4 op 

het antwoordblad 

❖ Schrijf ook de waarde van de molaire extinctiecoëfficiënt van het gereduceerde FC 

reagens op in het vak bij vraag 3.1.4 op het antwoordblad.  

Trek nu in de grafiek waarin je A tegen Cgalluszuur hebt uitgezet de rechte lijn met helling m door de 

meetpunten.  

❖ Teken op het millimeterpapier van vraag 3.1.3 de rechte lijn. 

1 - 3.2. Detectielimiet 

De detectielimiet (Engels: 'Limit of Detection' of 'LOD') is een zeer belangrijke waarde die iets zegt 

over de betrouwbaarheid waarmee een concentratie kan worden bepaald. Als je monsters bestudeert 

waarvan de concentratie onder de LOD ligt is het meestal nodig om de monsters eerst te concentreren. 

Volgens de IUPAC (International Union of Pure and Applied Chemistry) kan voor een gegeven 

meettechniek de LOD worden berekend door 3 maal de grootste standaarddeviatie (of 

standaardafwijking, σ) van een meting te delen door de helling van de kalibratielijn 

LOD = 3σ / helling 

Elke meetwaarde heeft een bepaalde onnauwkeurigheid, die je je voor kunt stellen als kleine 

afwijkingen van de 'ware waarde'. Als je bijvoorbeeld een oplossing van een bepaalde concentratie 

een aantal maal nauwkeurig maakt door telkens dezelfde massa van een verbinding af te wegen en 

die in hetzelfde volume oplosmiddel op te lossen, zullen de concentraties van de uiteindelijke 

oplossingen toch allemaal een klein beetje verschillen, door kleine onnauwkeurigheden in de 

handelingen die je uitvoert, maar ook kleine onnauwkeurigheden van de apparatuur die je gebruikt. 

De standaarddeviatie is een maat voor de onnauwkeurigheid en beschrijft als het ware de afstanden 

van de verschillende waarden tot de gemiddelde waarde.  

Je gaat nu de onnauwkeurigheid in je metingen van de extincties bij 635 nm bepalen door 5 replicaten 

van kalibratie-oplossing 1 te maken. Voor elk replicaat: 
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1. Pipetteer telkens nauwkeurig 500 µL van verdunning 1 in een bekerglas van 25 mL en voeg 

500 µL FC reagens toe. Roer, wacht 3 minuten en voeg dan 500 µL mL van de Na2CO3 oplossing 

toe. 

2. Maak de blanco-oplossing op dezelfde manier als de kalibratie-oplossingen, maar gebruik  

500 µL H2O in plaats van een verdunning. 

3. Roer de oplossingen en laat ze 30 minuten staan. 

4. Kalibreer de colorimeter met de blanco-oplossing. 

5. Meet na 30 minuten de extincties van de vijf gemaakte oplossingen bij een golflengte van 635 nm 

met behulp van de colorimeter. Schrijf de meetwaarden op in twee decimalen nauwkeurig. 

❖ Schrijf de waarden op in de tabel bij vraag 3.2.1 op het antwoordblad. 

De standaarddeviatie (σ) is een maat die gebruikt wordt om de variatie van een set 

meetwaarden aan te duiden. Een kleine standaarddeviatie geeft aan dat de meetwaarden 

allemaal dicht bij dezelfde waarde (hun gemiddelde) liggen, terwijl een grote 

standaarddeviatie aangeeft dat de waarden ver uit elkaar liggen. 

Voor een set meetwaarden kun je de standaarddeviatie uitrekenen door de wortel te 

trekken uit het gemiddelde van de kwadraten van de verschillen van de meetwaardes met 

hun gemiddelde waarde.  

Bijvoorbeeld, als we de acht waarden 2; 4; 4; 4; 5; 5; 7 en 9 gemeten hebben, dan is hun 

gemiddelde waarde gelijk aan 5. 

Nu gaan we eerst de verschillen van de acht waarden met hun gemiddelde berekenen en 

vervolgens de uitkomsten kwadrateren: 

(2-5)2=9 

(4-5)2=1 

(4-5)2=1 

(4-5)2=1 

(5-5)2=0 

(5-5)2=0 

(7-5)2=4 

(9-5)2=16 

Het gemiddelde van deze waarden op hun beurt is 4 en de wortel hieruit is 2. Dit is de 

standaarddeviatie σ. 

 

Vraag 3.2.2. 

Bereken met behulp van de standaarddeviatie en de helling de LOD van de galluszuurconcentratie. 

❖ Schrijf je berekeningen en het resultaat op, op het antwoordblad bij vraag 3.2.2  
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1 - 3.3. De analyse van kurkextracten en het beoordelen van de resultaten 

Vraag 3.3.1. 

Van de kurkplanken A, B en C uit opdracht 1 - 2, zijn extracten gemaakt. Elk extract is tienmaal 

geconcentreerd en vervolgens opgeslagen bij -20 °C om ervoor te zorgen dat het goed bewaard blijft. 

Je hebt drie van deze geconcentreerde extracten ("Lot A"; "Lot B" en "Lot C") gekregen om te 

analyseren. 

1. Pipetteer nauwkeurig 500 µL van het "Lot A" extract in een bekerglas van 25 mL en voeg 500 µL 

FC reagens toe. Roer, wacht 3 minuten en voeg dan 500 µL mL van de Na2CO3 oplossing toe. 

2. Herhaal punt 1 voor de "Lot B" en "Lot C" extracten. 

3. Maak de blanco-oplossing op dezelfde manier als de kalibratie-oplossingen, maar gebruik  

500 µL H2O in plaats van een verdunning. 

4. Roer de oplossingen en laat ze 30 minuten staan. 

5. Kalibreer de colorimeter met de blanco-oplossing. 

6. Meet na deze 30 minuten de extincties van de gemaakte oplossingen bij een golflengte van 

635 nm met behulp van de colorimeter. Schrijf de meetwaarden op in twee decimalen 

nauwkeurig. 

❖ Schrijf de meetwaarden op in de tabel bij vraag 3.3.1 op het antwoordblad. 

Vraag 3.3.2. 

Bepaal de totale fenolgehaltes van de gegeven kurkextracten. 

❖ Schrijf je berekeningen en antwoorden op in de tabel bij vraag 3.3.2 op het 

antwoordblad. 

Vraag 3.3.3. 

Is de detectielimiet van de methode laag genoeg om de oorspronkelijke extracten (dus zonder de 

concentratiestap) rechtstreeks te meten? 

❖ Beantwoord vraag 3.3.3 op het antwoordblad. 

Vraag 3.3.4. 

Gebruik de gegevens die je team heeft verzameld in opdracht 1 – 2 en 1 – 3 en de informatie bij de 

opdrachten. Welke kurkplank is geschikt om uitstekende stoppen van te maken? 

❖ Beantwoord vraag 3.3.4 op het antwoordblad. 
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OPDRACHT 1 – 4.: KURK ALS THERMISCHE ISOLATOR 

Inleiding  

In deze opdracht ga je een andere belangrijke eigenschap van kurk leren kennen en de toepassing 

ervan in de bouw. 

Het vermogen van een stof om warmte te kunnen geleiden noemt men de thermische geleiding. De 

lucht in de cellulaire structuur van de kurk maakt dat het een uitstekende thermische isolator is. Als 

thermische isolator van hoog niveau wordt kurk ook toegepast in de bouw- en ruimtevaartindustrie. 

Als uitstekende thermische isolator is kurk een slechte thermische geleider. 

Thermische geleiding 

Warmte is de energie die overgebracht wordt als gevolg van temperatuursverschil (van hoge naar 

lage temperatuur). Warmtetransport kan via verschillende mechanismen gebeuren, nl. geleiding, 

convectie en straling. Geleiding is een vorm van warmtetransport (of warmtestroom) binnenin een 

voorwerp of tussen voorwerpen in contact met elkaar, als gevolg van transport van kinetische energie 

door botsingen op microscopische schaal. Wanneer een kleine1 hoeveelheid warmte, of thermische 

energie, dQ wordt overgedragen in een heel klein2 tijdsinterval dt, wordt de warmtestroom 

gedefinieerd als H = dQ/dt. De warmtestroom door een homogeen voorwerp (zie Figuur 1 – 4.1) met 

lengte l (volgens de richting van de stroom) en met uniforme doorsnede A, bij een 

temperatuursverschil tussen de uiteinden gelijk aan T1 – T2 (met T1 en T2  respectievelijk de hoge en 

lage temperatuur), wordt gegeven door de formule: 

𝐻 =
d𝑄

d𝑡
= 𝑘𝐴 

𝑇1 − 𝑇2

𝑙
 , 

 

waarin k (de thermische geleidbaarheid) een positieve constante is die een functie is van de 

materialen waaruit het voorwerp bestaat. De verhouding (𝑇1 − 𝑇2)/𝑙 is het temperatuursverschil per 

eenheid van lengte. 

 

 

 

 

Figuur 1 – 4.1 Warmtetransport door een balk met lengte l  en dwarsdoorsnede A, geplaatst tussen 

twee voorwerpen met temperatuur T1 en T2 respectievelijk. Het temperatuursverschil tussen de twee 

kanten van de balk veroorzaakt een warmtestroom van de kant met de hoge temperatuur naar de kant 

met de lage temperatuur, zoals voorgesteld door de pijl.  

 

 

 

                                                
1 dx stelt een heel klein stukje van de grootheid x voor 
2 Merk op dat over het algemeen de warmtestroom verandert in de tijd. Dus om de warmtestroom H(t) op een tijdstip t te 
berekenen, moet je een zeer klein tijdsinterval rond t gebruiken. 
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Het doel van deze opdracht is de thermische geleidbaarheid te bepalen van een dun 

kurkmonster, door gebruik te maken van de Lee's schijfmethode, beschreven onder 1 - 4.1. 

Waarschuwing:  

Raak de hete-stoomgenerator niet aan. Richt de hete-stoomgenerator nooit naar jezelf of je 

collega's. Gebruik de tang wanneer je de hete-stoomkamer moet verplaatsen. Gebruik de 

pannenlap als je materialen op hoge temperatuur moet aanraken (stoomgenerator; Lee's schijf 

en rubberen slangen).  

 

Materialen en uitrusting (Figuur 1 - 4.2) 
● Stoomgenerator (A) met schuifknop (control slider, cs) 

● Stoomkamer (B) 

● Messing schijf (Lee’s schijf) (C) 

● Kunststof houder voor Lee’s schijf en stoomkamer (D) 

● Een dun kurkmonster (E) 

● Tang (F) 

● 2 geijkte temperatuursondes (G), om te verbinden met een TI-Nspire CX rekenmachine, via 

een data logging Lab Cradle interface 

● Texas Instruments TI-Nspire CX rekenmachine met een data logging Lab Cradle interface (H) 

● Thermische lijm (om het thermisch contact met de tempertuursondes te verbeteren) (label 

“Heat Sink Compound Plus”) (I)  

● Een dik isolerend kurkblok (J) 

● Een grote isolerende kurkondergrond (K) 

● Rubberen slangen (L) 

● Pannenlap (M) 

Figuur 1 - 4.2 – Algemeen experimenteermateriaal en uitrusting. 
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De methode bestaat uit twee delen gebruikmakend van twee verschillende proefopstellingen. 

 

1 - 4.1. Deel 1 van de Lee’s Schijfmethode 

Figuur 1 - 4.3 toont de eerste proefopstelling die je moet gebruiken om de thermische geleidbaarheid 

te meten van een  kurkmonster, gebruikmakend van de Lee's schijfmethode. Het kurkmonster (CK) 

heeft de vorm van een schijf. Je moet het plaatsen tussen de stoomkamercilinder (SC), en een messing 

schijf – the Lee’s disk (LD) – die gemonteerd zijn op een kunststof houder.  

 

 

Figuur 1 - 4.3 – Proefopstelling voor het eerste deel van de Lee’s schijfmethode om de thermische 

geleidbaarheid van een kurkmonster te bepalen. Links zie je het apparaat zelf, terwijl rechts 

schematisch is weergegeven hoe gegevens verzameld worden. SC – Stoomkamer; CK – 

Kurkmonster; LD – Lee’s disc; BB – messing ondergrond; TSC – Temperatuur van de bodem van de 

stoomkamer; TLD – Temperatuur van de Lee’s Disc; I – Stoom in; O - Stoom out; d – monster dikte. 

   

Wanneer de stoomgenerator, verbonden met de stoomkamer, ingeschakeld wordt, warmt de kamer 

op. De temperatuur TSC van de bodem van de stoomkamer, net boven het kurkmonster, kan gemeten 

worden met één van de temperatuursondes (T-SC). Een warmtestroom Hin stroomt van de kamer naar 

de Lee’s schijf door het kurkmonster en doet de temperatuur van de Lee’s schijf stijgen. De tweede 

temperatuursonde (T-LD), meet de temperatuur van de Lee’s schijf TLD die in contact is met de 

onderzijde van het kurkmonster. Wanneer TLD stijgt boven kamertemperatuur, stroomt er ook warmte 

(door geleiding, convectie en straling) van de Lee’s schijf naar de omgeving. Dus een warmtestroom 

Hout verlaat de Lee’s schijf.  Wanneer TLD stijgt, daalt Hin en stijgt Hout. Zodra Hin = Hout wordt er een 

stabiele toestand (de “steady state”) bereikt, en TSC en TLD blijven constant gelijk aan TH en TL 

respectievelijk. 

 

Werkwijze 

1. Gegeven zijn de volgende waarden: de massa van de Lee’s schijf, m = 629 g; hoogte van de Lee’s 

schijf, ℎ = 1,5 cm; diameter van de Lee’s schijf, 𝐷 = 8,0 cm en de dikte van het kurkmonster, 𝑑 

= 2,1 mm. Zet deze gegevens op het antwoordblad.  

❖ Vul de gegevens (in SI-eenheden) in in de tabel bij Vraag 4.1.1. op het antwoordblad. 
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2. Breng één van de temperatuursonden (T-SC) in de opening onder de stoomkamer, en de andere 

(T-LD) in de opening in de Lee’s schijf. Om een goed thermisch contact met de 

temperatuursondes te verzekeren, moet je thermische lijm smeren aan de top van elke sonde, vóór 

je ze in de gaten steekt. 

3. Verbind de twee temperatuursondes met de Lab Cradle data logging interface – om te weten hoe 

je dat moet doen en hoe je met de software van de TI-Nspire CX rekenmachine moet werken: 

raadpleeg Appendix 3. Begin de temperaturen TSC and TLD te monitoren gebruikmakend van de  

TI-Nspire CX rekenmachine (monitoring mode).  

4. Het reservoir van de stoomgenerator is al halfvol water en is klaar om te beginnen. Neem de slang 

of de afsluitklem niet weg. Verbind de soepele slang van de stoomgenerator met de ingang van 

de stoomkamer (dichtbij de bovenkant ervan). Hang de stoomuitgang (dichtbij de bodem van de 

stoomkamer) in de dichtstbijzijnde gootsteen. Verbind de hete plaat van de stoomgenerator met 

het stopcontact en stel in op “3.5-4” met de schuifknop. Als er een probleem is met de 

stoomproductie, vraag dan een zaalassistent om hulp. Je krijgt hier geen strafpunten voor. 

5. Breng de stoomkamer in contact met de Lee’s schijf. Schakel de stoomgenerator in en verwarm 

de schijf tot een temperatuur T = 60ºC. Dit gaat zeer snel. Overschrijd T= 65ºC niet. Gebruik 

de tang om de kamer goed vast te houden, neem deze van de kunststof houder en zet ze bovenop 

de grote isolerende kurkondergrond (K in Figuur 1 - 4.2). Als de temperatuur 65oC overschrijdt, 

wacht dan tot het weer afgekoeld is tot die waarde, alvorens verder te gaan met de volgende stap.  

6. Zet het kurkmonster op de bovenkant van de Lee’s schijf. Zet de stoomkamer, voorzichtig en 

gebruikmakend van de tang, bovenop het kurkmonster. Het kurk moet te zien zijn tussen de 

twee messing onderdelen van de proefopstelling (zie Figuur 1 - 4.3). Merk op dat het geheel nu 

terug op de kunststof houder staat. Verzeker je ervan dat de temperatuursondes correct geplaatst 

blijven.  

7. Herstart de meting van de temperaturen TSC en TLD  met de TI-Nspire CX rekenmachine. Noteer 

de waarden TH en TL op het antwoordblad, zodra TSC en TLD constant blijven. Merk op dat dit lang 

kan duren.  

Experiment 1 - 4.1 is beëindigd: zet de schakelaar op ‘0’ (als je dit experiment moet herhalen, roep 

dan een zaalassistent ) en verwijder de temperatuursonde T-SC van de data logging Lab Cradle 

interface. 

❖ Schrijf je resultaten in de tabel bij Vraag 4.1.2. op het antwoordblad. 

 

Vraag 4.1.3 

Geef op het antwoordblad de wiskundige uitdrukking voor de warmtestroom 𝐻𝑖𝑛 die in de Lee’s 

schijf stroomt bij de steady state. De uitdrukking dient geschreven te worden als functie van 𝑘 (de 

thermische geleidbaarheid van het kurkmonster) en van de andere gemeten grootheden met 

bijbehorende symbolen. 

❖ Schrijf je resultaten op bij Vraag 4.1.3. op het antwoordblad.   
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Vraag 4.1.4. 

Geef op het antwoordblad de wiskundige uitdrukking voor 𝑎 in 𝐻𝑖𝑛 = 𝑘𝑎. Deze uitdrukking voor 𝑎 

dient geschreven te worden als een functie van de gemeten grootheden met bijbehorende symbolen. 

Bereken een experimentele waarde voor 𝑎 uitgaande van de gemeten waarden van de grootheden 

(geef details van je berekeningen en druk de waarde uit in de juiste eenheid).  

❖ Schrijf je resultaten op bij Vraag 4.1.4. op het antwoordblad.  

 

1 - 4.2. Deel 2 van de Lee’s Schijf Methode 

Het doel van dit tweede deel van het experiment is om te meten hoe snel de Lee’s schijf afkoelt, 

m.a.w. zijn afkoelingssnelheid 𝑟, op de temperatuur waarbij deze zijn steady state bereikte. De 

afkoelingssnelheid van de Lee’s schijf is een functie van zijn temperatuur. Als de schijf op een 

gegeven temperatuur 𝑇 is, dan is zijn afkoelingssnelheid de verhouding tussen een kleine 

temperatuurverandering d𝑇𝐿𝐷 rondom 𝑇 en het korte tijdsinterval d𝑡 nodig voor deze verandering: 

𝑟(𝑇) = d𝑇𝐿𝐷/d𝑡. Bij de steady state kan de warmtestroom van de schijf naar de omgeving 𝐻𝑜𝑢𝑡 in 

verband worden gebracht met de afkoelingssnelheid met de vergelijking: 

 

𝐻out = 𝑚𝑐
d𝑇𝐿𝐷

d𝑡
 , 

  

met 𝑚 de massa van de Lee’s schijf en 𝑐 = 377 J/(kg K) de soortelijke warmte van het 

schijfmateriaal. De soortelijke warmte is de warmte nodig om de temperatuur van 1 kg van het 

materiaal met 1 graad Celcius te doen stijgen.  

In de volgende procedure laat je de temperatuur van de Lee’s schijf ongeveer 5 tot 10 ℃ boven 𝑇𝐿 

stijgen en laat je hem afkoelen terwijl je de temperatuur van de schijf continu meet. Het afkoelen 

komt door warmteoverdracht van de schijf naar de omgeving.  

 

Werkwijze 

1. Verwijder het kurkmonster van de vorige opstelling met de bijgeleverde pannenlap en tang als 

bescherming.  

2. Zet het vermogen van de stoomgenerator op “3,5-4” met de schuifknop. Als er enig probleem is 

met de stoomproductie, vraag dan hulp bij de zaalassistent. In dit deel van het experiment moet 

de TI-Nspire CX calculator in acquisition mode gebruikt worden. Kies een geschikte 

bemonsteringsfrequentie (Engels: 'sampling rate'). Neem data van de temperatuursonde T-LD en 

wacht totdat 𝑇𝐿𝐷 een waarde bereikt van ongeveer 5 tot 10 ℃ boven 𝑇𝐿. 

3. Zet de schuifkop naar “0” en verbreek de verbinding met de spanningsbron. Verwijder de 

stoomkamer, met de pannenlap en tang als bescherming, en plaats hem op de grote 

kurkenondergrond (K in Figuur 1 – 4.2). Plaats het isolatieblok (J in Figuur 1-4.2) op de schijf en 

meet de temperatuur 𝑇𝐿𝐷 als functie van tijd. 
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Vraag 4.2.1. 

Selecteer geschikte waarden van de verzamelde data om de afkoelende warmtestroom van de schijf 

naar de omgeving te bepalen bij de temperatuur van de steady state gevonden bij Vraag 4.1.2. 

❖ Schrijf je resultaten op in de tabel bij Vraag 4.2.1. op het antwoordblad.  

Vraag 4.2.2. 

Maak een grafiek van de data van de tabel (Vraag 4.2.1.) op het geleverde millimeterpapier op het 

antwoordblad.  

❖ Maak een grafiek op het geleverde millimeterpapier op het antwoordblad. 

Vraag 4.2.3. 

Gebruik de grafiek om de afkoelingssnelheid 𝑟 te bepalen bij de temperatuur van de steady state 

gevonden bij Vraag 4.1.2.. Geef je berekeningen weer op het antwoordblad en geef aan welke 

waarden je hebt gebruikt.  

❖ Schrijf je berekeningen en resultaten op bij Vraag 4.2.3. op het antwoordblad.  

Vraag 4.2.4. 

Geef op het antwoordblad een wiskundige uitdrukking voor de thermische geleidbaarheid 𝑘  van het 

kurkmonster als functie van 𝑚, 𝑐 en eventuele andere grootheden van je verzamelde experimentele 

data. Bereken met deze uitdrukking de thermische geleidbaarheid 𝑘 van je kurkmonster.  

❖ Schrijf je resultaten op bij Vraag 4.2.4. op het antwoordblad.  

 

1 - 4.3. Thermische Isolatie van Huizen 

De thermische weerstand 𝑅 van een plaat is een maat voor zijn thermische isolatie tegen 

warmteverliezen en kan gedefinieerd worden als: 

 

met 𝑘 de thermische geleidbaarheid van het materiaal en 𝑙 de plaatdikte. In gebouwen zijn de wanden 

opgebouwd uit lagen van verschillende materialen. Als de oppervlakten aan binnen- en buitenzijde 

verschillende temperaturen hebben, zal een warmtestroom 𝐻 door alle wandlagen heen stromen. 

Vraag 4.3.1. 

Leid een wiskundige uitdrukking af voor de totale thermische weerstand 𝑅totaal van een wand met 

twee lagen met dikte 𝑙1 en 𝑙2 van materialen met verschillende thermische geleidbaarheid 𝑘1 en 𝑘2, 

respectievelijk, als functie van alleen deze grootheden. 

❖ Schrijf je berekeningen en resultaten op bij Vraag 4.3.1. op het antwoordblad.  
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Vraag 4.3.2. 

Om verliezen door thermische geleiding te vermijden bij een huis met wanden gemaakt van 20 cm 

dik beton en een 2 cm dikke pleisterlaag, is een isolatielaag van 1 cm dik kurkplaat toegevoegd. Neem 

aan dat de betonlaag aan de buitenkant van het huis een temperatuur van 0 ºC heeft en de temperatuur 

binnen het huis op 20 ºC wordt gehouden. Bereken de energie die gedurende één uur verloren gaat 

door een muur met een oppervlakte van 50 m2  voor de volgende twee gevallen: 

i) een kale (beton+pleister, niet geïsoleerde) muur; 

ii) een geïsoleerde (beton+pleister+kurk) muur. 

Gebruik de volgende thermische geleidbaarheden (gegeven in de SI eenheid W K-1 m-1): beton: 1,10; 

pleister: 0,17; kurk: gebruik de waarde gevonden bij Vraag 4.2.4. 

❖ Schrijf je berekeningen en resultaten op bij Vraag 4.3.2. op het antwoordblad.  

 


